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Chapter 273 

Confidence Intervals for 
One-Sample Sensitivity 
and Specificity 
Introduction 
This procedures calculates the (whole table) sample size necessary for both sensitivity and specificity confidence 
intervals, based on a specified sensitivity and specificity, interval width, confidence level, and prevalence.  

Caution: This procedure assumes that the sensitivity and specificity of the future sample will be the same as the 
sensitivity and specificity that is specified. If the sample sensitivity or specificity is different from the one 
specified when running this procedure, the interval width may be narrower or wider than specified.  

Sensitivity (True Positive Rate) 
The sensitivity (or true positive rate) is the proportion of the individuals with a known positive condition for 
which the predicted condition is positive.  
 

 
 

 

 

 

 

Specificity (True Negative Rate) 
The specificity (or true negative rate) is the proportion of the individuals with a known negative condition for 
which the predicted condition is negative.  
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Prevalence 
The prevalence is the overall proportion of individuals with a positive condition. 
 

 
 

 

 

 

 

Technical Details 
In general terms, the required sample size is determined as the larger of two (whole table) sample sizes needed for 
each of the sensitivity and specificity confidence intervals, including appropriate prevalence adjustments.  

Sensitivity Confidence Interval Sample Size Calculation 
The initial sample size calculation for the sensitivity confidence interval gives the number of individuals with a 
positive condition that are needed. The prevalence adjustment is used to add the number of individuals with a 
negative condition that are needed. The resulting sample size is the total number of individuals needed to obtain a 
table where the number of positive condition individuals will give the needed confidence interval width for the 
sensitivity. 

Similarly, when calculating the confidence interval width for a given sample size, the given sample size is first 
used to produce the number of positive condition individuals, according to the given prevalence, and then the 
width based on the resulting positive condition count is then calculated. 

Specificity Confidence Interval Sample Size Calculation 
The initial sample size calculation for the specificity confidence interval gives the number of individuals with a 
negative condition that are needed. The prevalence adjustment is used to add the number of individuals with a 
positive condition that are needed. The resulting sample size is the total number of individuals needed to obtain a 
table where the number of negative condition individuals will give the needed confidence interval width for the 
specificity. 

Similarly, when calculating the confidence interval width for a given sample size, the given sample size is first 
used to produce the number of negative condition individuals, according to the given prevalence, and then the 
width based on the resulting negative condition count is then calculated. 
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Confidence Interval Formulas 
Many methods have been devised for computing confidence intervals for a single proportion. Five of these 
methods are available in this procedure. The five confidence interval methods are 

1. Exact (Clopper-Pearson)  

2. Score (Wilson) 

3. Score with continuity correction 

4. Simple Asymptotic 

5. Simple Asymptotic with continuity correction 

For a comparison of methods, see Newcombe (1998a). 

For each of the following methods, let p be the population sensitivity, and let r represent the number of true 
positives with n total positives. Let nrp /ˆ = . 

Exact (Clopper-Pearson) 
Using a mathematical relationship (see Fleiss et al (2003), p. 25) between the F distribution and the cumulative 
binomial distribution, the lower and upper confidence limits of a 100(1-α)% exact confidence interval for the true 
proportion p are given by 
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One-sided limits may be obtained by replacing α/2 by α. 

Score (Wilson) 
The Wilson Score confidence interval, which is based on inverting the z-test for a single proportion, is calculated 
using 
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One-sided limits may be obtained by replacing α/2 by α. 

Score with Continuity Correction 
The Score confidence interval with continuity correction is based on inverting the z-test for a single proportion 
with continuity correction. The 100(1-α)% limits are calculated by 

Lower Limit = 
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Upper Limit = 
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One-sided limits may be obtained by replacing α/2 by α. 
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Simple Asymptotic 
The simple asymptotic formula is based on the normal approximation to the binomial distribution. The 
approximation is close only for very large sample sizes. The 100(1-α)% confidence limits are given by 
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One-sided limits may be obtained by replacing α/2 by α. 

Simple Asymptotic with Continuity Correction 
This formula is identical to the previous one, but with continuity correction. The 100(1-α)% confidence limits are 
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One-sided limits may be obtained by replacing α/2 by α. 

Interval Widths (One-Sided vs. Two-Sided) 
For two-sided intervals, the distance from the sample sensitivity to each of the limits may be different. Thus, instead 
of specifying the distance to the limits we specify the width of the interval, W.  

The basic equation for determining sample size for a two-sided interval when W has been specified is 

LUW −=  

For one-sided intervals, the distance from the sample sensitivity to limit, D, is specified. 

The basic equation for determining sample size for a one-sided upper limit when D has been specified is 

pUD ˆ−=  

The basic equation for determining sample size for a one-sided lower limit when D has been specified is 

LpD −= ˆ  

Each of these equations can be solved for any of the unknown quantities in terms of the others. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters.  
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Confidence Interval Method 

Confidence Interval Formula 
Specify the formula to be in used in calculation of confidence intervals. 

• Exact (Clopper-Pearson) 
The exact formula uses the binomial probabilities directly. 

• Score (Wilson) 
This formula is based on inverting a critical ratio test. 

• Score (Continuity Correction) 
This formula is based on inverting a critical ratio test with continuity correction. 

• Simple Asymptotic 
The simple asymptotic formula is based on the normal approximation to the binomial. 

• Simple Asymptotic (Continuity Correction) 
This formula is based on the normal approximation to the binomial with continuity correction.  

One-Sided or Two-Sided Interval 

Interval Type 
Specify whether the intervals to be used will be two-sided confidence intervals, intervals that have only an upper 
limit, or intervals that have only a lower limit. 

Confidence 

Confidence Level 
Enter the confidence level (or confidence coefficient). This is the proportion of confidence intervals (constructed 
with this same confidence level, sample size, etc.) that contain the population sensitivity or specificity. 

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90, 0.95 or 0.90 
to 0.99 by 0.01. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at random from the 
population to be in the study. 

You can enter a single value or a range of values. 

Precision 

Confidence Interval Width (Two-Sided) 
This is the distance from the lower confidence limit to the upper confidence limit. 

You can enter a single value or a list of values. The value(s) must be between 0 and 1.  
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Distance from Sensitivity to Limit (One-Sided) 
This is the distance from the sample sensitivity or sample specificity to the lower or upper limit of the confidence 
interval, depending on whether the Interval Type is set to Lower One-Sided or Upper One-Sided. 

You can enter a single value or a list of values. The value(s) must be between 0 and 1.  

Sensitivity 

Sensitivity 
Enter an estimate of the sensitivity (or true positive rate). The sample size and width calculations assume that the 
value entered here is the sensitivity estimate that is obtained from the sample. If the sample sensitivity is different 
from the one specified here, the width may be narrower or wider than specified. 

You can enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.  

Specificity 

Specificity 
Enter an estimate of the specificity (or true negative rate). The sample size and width calculations assume that the 
value entered here is the specificity estimate that is obtained from the sample. If the sample specificity is different 
from the one specified here, the width may be narrower or wider than specified. 

You can enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.  

Prevalence 

Prevalence 
Enter the value of the assumed prevalence. The Prevalence is the assumed overall proportion of individuals with a 
positive condition. The sample size calculations for the sensitivity and specificity confidence intervals are 
concerned with the number of positive condition and negative condition individuals, respectively. The prevalence 
is used to produce the total sample size needed to generate the proper number of positive condition and negative 
condition individuals. 
 

You can enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.  
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Example 1 – Calculating Sample Size 
Suppose a study is planned in which the researcher wishes to construct two-sided 95% exact (Clopper-Pearson) 
confidence intervals for the population sensitivity and specificity such that the widths of the intervals are no wider 
than 0.06. The anticipated sensitivity estimate is 0.7, but a range of values from 0.5 to 0.9 will be included to 
determine the effect of the sensitivity estimate on necessary sample size. The anticipated specificity is 0.6. Instead 
of examining only the interval width of 0.06, widths of 0.04, 0.08, and 0.10 will also be considered. 
The goal is to determine the total sample size needed when also accounting for 20% to 60% prevalence. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Confidence Intervals for One-Sample Sensitivity and Specificity procedure. You may make 
the appropriate entries as listed below or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Confidence Interval Formula .................. Exact (Clopper-Pearson) 
Interval Type ........................................... Two-Sided 
Confidence Level .................................... 0.95 
Confidence Interval Width (Two-Sided) .. 0.04 0.06 0.08 0.10 
Sensitivity ................................................ 0.5 to 0.9 by 0.05 
Specificity ................................................ 0.6 
Prevalence .............................................. 0.2 to 0.6 by 0.1 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals for One-Sample Sensitivity and Specificity 
Confidence Interval Formula: Exact (Clopper-Pearson) 
 
       Required  
    Sample  Sample Sample Sens. C.I. Spec. C.I. 
Confidence  Target Sensi- Size for Speci- Size for Size Width Width 
Level Prev Width tivity Sens. C.I. ficity Spec. C.I. (N) with N with N 
0.950 0.200 0.040 0.500 12245 0.600 2942 12245 0.040 0.020 
0.950 0.300 0.040 0.500 8164 0.600 3362 8164 0.040 0.026 
0.950 0.400 0.040 0.500 6123 0.600 3922 6123 0.040 0.033 
0.950 0.500 0.040 0.500 4898 0.600 4706 4898 0.040 0.040 
0.950 0.600 0.040 0.500 4082 0.600 5883 5883 0.033 0.041 
0.950 0.200 0.040 0.550 12125 0.600 2942 12125 0.040 0.020 
0.950 0.300 0.040 0.550 8084 0.600 3362 8084 0.040 0.026 
0.950 0.400 0.040 0.550 6063 0.600 3922 6063 0.040 0.033 
0.950 0.500 0.040 0.550 4850 0.600 4706 4850 0.040 0.040 
0.950 0.600 0.040 0.550 4042 0.600 5883 5883 0.033 0.041 
0.950 0.200 0.040 0.600 11765 0.600 2942 11765 0.040 0.020 
0.950 0.300 0.040 0.600 7844 0.600 3362 7844 0.040 0.026 
. . . . . . . . . .  
. . . . . . . . . . 
. . . . . . . . . . 
 
[report continues] 
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Report Definitions 
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, 
   sample size, etc.) that would contain the population sensitivity or specificity. 
Prevalence is the assumed overall proportion of individuals with a positive condition. 
Target Width is the desired distance from the lower limit to the upper limit. 
Sensitivity is the assumed sample sensitivity, or true positive rate. 
Sample Size for Sensitivity Confidence Interval is the whole table sample size needed to obtain the desired 
   sensitivity confidence interval width. 
Specificity is the assumed sample specificity, or true negative rate. 
Sample Size for Specificity Confidence Interval is the whole table sample size needed to obtain the desired 
   specificity confidence interval width. 
Required Sample Size (N) is the whole table sample size that is needed to give the desired confidence interval 
   width for both the sensitivity and specificity. It is the larger of the two sample sizes. 
Sensitivity Confidence Interval Width with N is the distance from the sensitivity confidence interval lower 
   limit to the upper limit when the sample size is N. 
Specificity Confidence Interval Width with N is the distance between the specificity confidence interval lower 
   limit to the upper limit when the sample size is N. 
 
Summary Statements 
Assuming a prevalence of 0.200 and a sample sensitivity of 0.500, the sample size needed for a 
two-sided 95% sensitivity confidence interval with a width of at most 0.040, is 12245. Assuming 
a prevalence of 0.200 and a sample specificity of 0.600, the sample size needed for a two-sided 
95% specificity confidence interval with a width of at most 0.040, is 2942. The whole table 
sample size required so that both confidence intervals have widths less than 0.040, is 12245, 
the larger of the two sample sizes. 
 
 
Dropout-Inflated Sample Size 
  Dropout-  
  Inflated Expected 
  Enrollment Number of 
 Sample Size Sample Size Dropouts 
Dropout Rate N N' D 
20% 12245 15307 3062 
20% 8164 10205 2041 
20% 6123 7654 1531 
20% 4898 6123 1225 
20% 5883 7354 1471 
20% 12125 15157 3032 
20% 8084 10105 2021 
20% 6063 7579 1516 
20% 4850 6063 1213 
20% 5883 7354 1471 
20% 11765 14707 2942 
. . . . 
. . . . 
. . . . 
 
 
Definitions 
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the 
   course of the study and for whom no response data will be collected (i.e. will be treated as "missing"). 
N is the evaluable sample size at which the confidence interval is computed. If N subjects are evaluated out 
   of the N' subjects that are enrolled in the study, the design will achieve the stated confidence interval. 
N' is the total number of subjects that should be enrolled in the study in order to end up with N evaluable 
   subjects, based on the assumed dropout rate. After solving for N, N' is calculated by inflating N using the 
   formula N' = N / (1 - DR), with N' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., 
   Shao, J., and Wang, H. (2008) pages 39-40.) 
D is the expected number of dropouts. D = N' - N. 
 

These reports show the calculated sample size for each of the scenarios.  
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Plots Section 
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These plots show the sample size versus the sample sensitivity and prevalence for the four confidence interval 
widths. It can be seen in the plots where the sample size depends on the sensitivity, and where it depends on the 
specificity. 
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Example 2 – Validation for Sensitivity Confidence Interval using 
Hajian-Tilaki (2014) 
Hajian-Tilaki (2014), page 195, gives an example of a calculation for a simple asymptotic two-sided confidence 
interval for a single sensitivity when the confidence level is 95%, the sensitivity is 0.8, the prevalence is 0.1, and 
the margin of error is 7% (With a margin of error (precision) of 7%, the width is 0.14). The necessary sample size 
is calculated to be 1254.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Confidence Intervals for One-Sample Sensitivity and Specificity procedure. You may make 
the appropriate entries as listed below or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Confidence Interval Formula .................. Simple Asymptotic 
Interval Type ........................................... Two-Sided 
Confidence Level .................................... 0.95 
Confidence Interval Width (Two-Sided) .. 0.14 
Sensitivity ................................................ 0.8 
Specificity ................................................ 0.8 
Prevalence .............................................. 0.1 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals for One-Sample Sensitivity 
Confidence Interval Formula: Simple Asymptotic 
 
       Required  
    Sample  Sample Sample Sens. C.I. Spec. C.I. 
Confidence  Target Sensi- Size for Speci- Size for Size Width Width 
Level Prev Width tivity Sens. C.I. ficity Spec. C.I. (N) with N with N 
0.950 0.100 0.140 0.800 1260 0.800 140 1260 0.140 0.047 
 

PASS calculates the necessary sample size to be 1260. The sample size calculated in PASS is slightly different 
from the article. In the article the sample sizes are calculated directly, while PASS calculates the sample size 
needed before prevalence is taken into account, and then adjusts for the prevalence. With a sample size of 1254, 
the number of positives would be 125.4, which should be rounded up to 126. Adjusting 126 for prevalence gives 
1260. 
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Example 3 – Validation for Specificity Confidence Interval using 
Hajian-Tilaki (2014) 
Hajian-Tilaki (2014), page 196, gives an example of a calculation for a simple asymptotic two-sided confidence 
interval for a single specificity when the confidence level is 95%, the specificity is 0.8, the prevalence is 0.1, and 
the margin of error is 3% (With a margin of error (precision) of 3%, the width is 0.06). The necessary sample size 
is calculated to be 759.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Confidence Intervals for One-Sample Sensitivity and Specificity procedure. You may make 
the appropriate entries as listed below or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Confidence Interval Formula .................. Simple Asymptotic 
Interval Type ........................................... Two-Sided 
Confidence Level .................................... 0.95 
Confidence Interval Width (Two-Sided) .. 0.06 
Sensitivity ................................................ 0.8 
Specificity ................................................ 0.8 
Prevalence .............................................. 0.1 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Two-Sided Confidence Intervals for One-Sample Sensitivity 
Confidence Interval Formula: Simple Asymptotic 
 
       Required  
    Sample  Sample Sample Sens. C.I. Spec. C.I. 
Confidence  Target Sensi- Size for Speci- Size for Size Width Width 
Level Prev Width tivity Sens. C.I. ficity Spec. C.I. (N) with N with N 
0.950 0.100 0.060 0.800 6830 0.800 759 6830 0.060 0.020 
 

PASS also calculates the necessary sample size to be 759. For some entries in the table, the sample size calculated 
in PASS is slightly different from the article. In the article the sample sizes are calculated directly, while PASS 
calculates the sample size needed before prevalence is taken into account, and then adjusts for the prevalence.  
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